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Structure Searching with Beilstein 
CrossFire 

This guide to structure searching complements the basic Beilstein CrossFire guide. 

Searching chemistry databases using a query defined as a chemical structure is a sophisticated and 
powerful technique, more precise and less open to ambiguity as a search and retrieve process than other 
types of query that you could use e.g. chemical name or chemical formula. It is usually easier to maximise 
exactness and precision in your search query by defining it as a pictorial structure, drawing out the atoms 
and bonds, as you would on paper. 

 

What will a structure search give you? 

The search will retrieve from the database all the 
information held on the substance you have 
defined in your search query. In many cases this 
is a very considerable list of reactions and data. 
The results data are hierarchically categorised 
with the hierarchy tree fanning out into several 
hundred individual categories, e.g. UV spectrum, 
dipole moment, conformation, triple point, critical 
pressure, enthalpies, refractive index, magnetic 
susceptibility, isoelectric point etc. The results will 
very often be a substantial set of data categories, 
but may sometimes be limited to only a few basic 
categories, according to what has been reported 
in the primary literature. Practically all searches 
will return basic data like melting and boiling 
points, molecular weight etc. 
 
The results are presented in a separate window 
as one page, usually very long. You will therefore 
need to use the scroll bar on the right to bring the 
data of interest into view on the screen. At the top 
of each results page there will be a list, the Field 
Availability List, of all of the categories for which 
data has been retrieved and presented further 
down the screen. 
 
Examine this list to see what is available and 
whether the particular piece of information you 
want is given. Use it as an index to the information 
your search has retrieved. The rest of the page 
expands the list, in the same order, citing the 
published work in which that item of data was 

reported, and often including the actual value of 
that piece of data. 
 
As well as the usually wide range of data, the 
search result will contain details of all the 
chemical reactions known and reported for the 
substance you have specified in your query. The 
reactions are listed immediately following the Field 
Availability List and are in turn followed by the 
data categories. 
 
The format for the search results is therefore: 

• Substance identification details 
• Field Availability List 
• Reactions and citations 
• Data and citations. 

Starting your search 

Set up and start the Beilstein CrossFire software 
as described in the companion to this guide, 
Beilstein CrossFire. Choose the database you 
require by clicking at upper left. Use Beilstein for 
organic chemistry; Gmelin for inorganic, 
organometallic and coordination chemistry. 

How to define and execute your search 
as a structure query   

The Beilstein Commander window is the master 
window through which you can enter and leave 
the various sub-windows e.g. a window for 
drawing/editing the structure query, another for 
viewing the results. 



Open the Structure Editor window using the 
Structure button near the centre of the Beilstein 
Commander screen. 
 
The structure must be drawn carefully and 
accurately, or copied, in the Structure Editor 
window, using the tools provided to the left and 
above. These are broadly similar to other 
chemistry drawing packages. 
 
Use Pencil to draw atoms one by one, i.e. 
position the cursor and click; and then connect 
them together with bonds . The current element is 
chosen from the shortlist at the top left, the rest of 
the full set of elements being accessed through a 
pull-down menu. A click on Element will display a 
full periodic table. Click the element you want and 
then click OK. 
 
Similarly, choose a current bond type (e.g. single, 
double etc.) from those at centre top, or others 
from the pull-down menu. Draw the bond by 
placing the cursor at the start atom, click and, 
holding the mouse button down, move the cursor 
to the other atom and release the button. 
 
Mistakes can be reversed using Undo, in the Edit 
menu, or Ctrl+Z. Use rubber to remove anything. 
There is no display of the molecular formula of the 
structure that you generate. If you need this, you 
have to do it separately on paper. 
 
When your drawn structure is complete, return to 
the commander window where it will be displayed. 
Initiate the search using the blue Start Search 
key. Small dialogue boxes will indicate the 
progress of the search and its results (nil is a 
possible result). Use the Display Hits key in this 
box to display the results window, which will 
appear, as described above. 

Advanced tools and features 

The basic pencil and rubber are supplemented 
with a range of more powerful and sophisticated 
tools. 
 
Any part of the structure that is to be the subject 
of further editing (e.g. moving, copying, rotating, 
bulk deletion etc.) must first be selected. 

Select tool 

To select individual atoms or bonds, activate the 
Select tool (by clicking on the select icon, 
immediately below the pencil, on the left toolbar) 
then click on individual atoms or bonds. Double 
click anywhere on the structure to select the entire 
structure. When selected, single items (bonds or 
atoms) will appear highlighted. Larger parts will be 
enclosed in a double-lined box to indicate their 
selected status.  

Lasso tool 

Use the Lasso tool to select any portion of the 
structure. With the left mouse button held down, 
draw a loop around the part you wish to select 
and release the button. To de-select, click with the 
cursor positioned anywhere on the blank 
background  

Rotate tool 

The entire structure must be selected (i.e. 
enclosed in a double-lined box) before this tool is 
engaged from the left toolbar. Upon clicking on 
the rotate icon, a plain cross will appear in the 
centre of the selected/highlighted structure. This 
marks the centre of rotation. This cross mark can 
be moved to anywhere else using a click-drag. 
Note that repositioning it outside the structure will 
not result in the structure rotating upon itself. To 
perform the rotation, click on the structure and 
drag in an arc. The cross will remain until the 
rotate tool is disengaged with a further click on its 
icon, or until pencil is again used. 

Templates 

Various common structural themes/motifs/ 
fragments are available to use as basic building 
blocks, and the one you choose will draw itself 
instantly on the screen e.g. chains , rings etc. All 
of these can be used as is, or used as a starting 
point for another structure, with subsequent 
editing . Simple ring forms, C3 to benzene, are 
obtained with a single click on the appropriate 
icon in the toolbar at upper right. 
A vast range of some 530 more complex 
templates are available through File menu Group 
Template 
 



This will produce a dialogue box setting out the 
classes of templates available. Choosing one will 
then show all the individual templates in that 
family. You may have to use the scroll bar to see 
them all. Double click on the one you want and 
the structure window will return, with the chosen 
structure displayed, ready for you to use. As a 
short-cut to these several steps, a click on the 
icon next to benzene on the top toolbar, will show 
one of the family sets of templates, usually the 
last used set. If you want a different set, use the 
File menu route to obtain it. 

How atoms and structures appear on the 
screen 

The default structural representation does not 
show carbon atoms as explicit atoms, i.e. there is 
no “C” symbol shown at the junction of the bonds. 
Other options are available e.g. showing all atoms 
as sequential numbers, or as their proper 
chemical element symbol. 
 
Use the Molecule View dialogue box, obtained 
through the Options pull-down menu, to change 
the way the atoms actually appear on the screen. 
It is not possible to show element symbols and 
position numbers simultaneously. Please note 
that, by convention, Hydrogen atoms and their 
bonds are not shown. You can however, for clarity 
and your own peace of mind, include them in the 
structure you draw. 

Saving result sets 

Within the current session, all of the result sets 
that your queries have retrieved are available for 
redisplay, at any point. They are given, by default, 
sequential numbers starting with Q to identify 
them e.g. Q01, Q02 etc.  You will lose all these 
result sets when you terminate the session, 
unless you take specific action to save them. 
 
You can save individual result sets for further use. 
They are saved at the Beilstein server end, not on 
your computer, disk, or the University network. 
They cannot be downloaded or saved onto a disk. 
 
To initiate the save instructions you must be in the 
Display Hits window. File menu, Save Hitset as 
will produce a dialogue box where you enter a file 

name of your choice. The box will also list the 
other result sets being stored for you. 
 
The query itself, i.e. the structure you have drawn 
(or a fact-based query ) can be saved to any disk 
destination, in the ordinary way. The saved query 
file will have the name of your choice, and the file 
extension .BSD  You will find there is already a 
sub-directory titled BSD in your network filespace, 
or you can direct the file to your own disk in drive 
A:  You must be in the Commander window to 
save a query. File pull-down menu Save As will 
produce a dialogue box. Enter fi le name and path 
details, then use the Save  button. 

Reusing saved items 

To display a hitset that you saved in a previous 
session, you must be in the Display Hits window. 
In the File pull-down menu click on Open Hitset. 
A dialogue box will appear showing what you 
have previously saved, plus the hitsets of the 
current session. Double click on the set that you 
want. It is possible to open more than one hitset at 
a time. 
 
To reload and reuse a previously saved query 
(structure or fact), you must be in the commander 
window. Use the File pull-down menu and click on 
Open  A dialogue box listing the queries you have 
previously saved will appear. This lists the files 
that have been saved to (by default ) your network 
filespace. If the file you want is elsewhere, e.g. on 
your own disk in the A: drive, you will have to set 
up the correct path details in the box. Choose the 
file you want i.e. it will become highlighted, and 
use the Open button in the dialogue box. 

Some general points 

• Tools remain selected and active until 
replaced by another. 

• Notice that the cursor will show an A or B 
when positioned on an Atom or Bond. Use 
this cue to help in accurate positioning of the 
cursor, and avoid mistakes. 

• For most of the commands, operations, and  
processes , there are other ways or routes to 
the same end, which can sometimes be 
quicker. You will discover these with 
familiarity and regular use. 



• Co-ordination compounds are not handled in 
the way you usually see them printed in books 
etc. Retrieve and examine e.g. ferrocene, 
tris(acelylacetonato) Cobalt (III) , or 
chlorophyll a to see how they are different 
from what you will see in print. 

 
• When in any of the subsidiary windows, use 

the ? BC button to return to the main window. 
 
• It is possible to define a query and search 

using specific stereochemistry, i.e. showing 
“up” and “down” bonds in the structure. You 
are recommended to first become familiar 
with the exact conventions used by Beilstein 
CrossFire for representing stereochemistry 
by, for example, exploring compounds whose 
stereochemistry you are familiar with and 
using the relevant sections of the online 
manuals. 

 
• Beilstein Commander is a very powerful and 

sophisticated search and retrieve tool. It has 
many more features and facilities than the 
basic ones described here. If you expect to 
use Beilstein CrossFire a lot, a good 
investment will be some of your time spent 
with the online manuals and tutors that are 
available. 

Some common errors 

• Failure to click OK in a dialogue box. 
• Lack of precision in cursor control in drawing 

structures. 
• Attempting operations whilst in the wrong 

window. 

Manuals and tutors 

Comprehensive written manuals, describing in 
detail all its features and how to use them support 
Beilstein CrossFire. These are available online at 
the Mimas website 
www.mimas.ac.uk/crossfire/docs.html 
The manual listed, near the bottom of the page, 
as “NEW Beilstein Database Reference Guide” 
covers everything and has a very comprehensive 
index. The other manuals shown cover more 
limited topics. 

Also excellent, and new, is the online interactive 
tutor called Firepower, 
www.mimas.ac.uk/crossfire/firepower 
It contains both introductory and advanced levels. 
You need to enter your Athens username and 
password to use Firepower. 
 

 
For further information or assistance contact the 
Science Library 
Tel: 029 2087 4085  Email: SciLiby@Cardiff.ac.uk  
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